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“ADOBE PHOTOSHOP”

AdobePhotoshop

Adobe Photoshop is a graphics editing program developed and published by
AdobeSystems.

Adobe's2003"CreativeSuite"rebrandingledtoAdobePhotoshop8'srenamingtoAdobe
Photoshop CS. Thus, Adobe Photoshop CS6 is the 13th major release of Adobe
Photoshop. The CS rebranding also resulted in Adobe offering numerous software
packages containingmultiple Adobe programs for a reduced price. Adobe Photoshop is
released in two editions: Adobe Photoshop, and Adobe Photoshop Extended, with the
Extendedhavingextra3Dimagecreation,motiongraphicsediting,andadvancedimage
analysisfeatures.AdobePhotoshopExtendedisincludedinallofAdobe'sCreativeSuite
offerings except Design Standard, which includes the Adobe Photoshop edition.

Alongside Photoshop and Photoshop Extended, Adobe also publishes
PhotoshopElementsandPhotoshopLightroom,
collectivelycalled"TheAdobePhotoshopFamily".
In2008,AdobereleasedAdobePhotoshopExpress,afreeweb-basedimageeditingtool to
edit photos directly on blogs and social networking sites; in 2011 a version was
released for the Android operating system and the iOS operating system.

FileFormat

Photoshop files have default file extension as .PSD, which stands for "Photoshop
Document." A PSD file stores an image with support for most imaging options available
in Photoshop. These include layers with masks, transparency, text, alphachannels and
spot colors, clipping paths, and duotone settings. This is in contrast to many other file
formats (e.g. .JPG or .GIF) that restrict content to provide streamlined, predictable
functionality. A PSD file has amaximum height and width of 30,000 pixels, and a length
limit of 3 Gigabytes.

Photoshop files sometimes have the file extension .PSB, which stands for "Photoshop
Big" (also known as "large document format"). A PSB file extends the PSD file format,
increasingthemaximumheightandwidthto300,000pixelsandthelengthlimittoaround
4Exabyte.ThedimensionlimitwasapparentlychosenarbitrarilybyAdobe,notbasedon
computer arithmetic constraints (it is not close to a power of two, as is 30,000) but for
ease of software testing. PSD and PSB formats are documented.

Because of Photoshop's popularity, PSD files are widely used and supported to some
extent by most competing software. The .PSD file format can be exported to and from
Adobe'sotherappslikeAdobeIllustrator,AdobePremierePro,andAfterEffects,tomake
professional standardDVDs and provide non-linear editing and special effects services,
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suchasbackgrounds,textures, andsoon,fortelevision,film,andthe web.Photoshop's
primary strength is as a pixel-based image editor, unlike vectorbased image editors.
PhotoshopalsoenablesvectorgraphicseditingthroughitsPaths,Pentools,Shapetools,
Shape Layers, Type tools, Import command, and Smart Object functions. These tools
and commandsareconvenient to combine pixel-based and vector-based imagesin one
Photoshop document, because it may not be necessary to use more than one program.
To create very complex vector graphics with numerous shapes and colors, it may be
easier to use software that was created primarily for that purpose, such as Adobe
Illustrator or CorelDraw. Photoshop's non-destructive Smart Objects can also import
complex vector shapes.

LanguageAvailabilities

Photoshopisavailableinmorethan20languages.Thesearethefollowing:

ChineseSimplified,ChineseTraditional,Czech,Danish,Dutch,English,Finnish,French,
German, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Portuguese,
Romanian,Russian,Spanish,Swedish,TurkishandUkrainian.AlsoArabicandHebrew as of
Photoshop CS6.

Plugins

Photoshop functionality can be extended by add-on programs called Photoshopplugins
(or plug-ins). Adobe creates some plugins, such as Adobe Camera Raw, but third-party
companiesdevelopmostplugins,accordingtoAdobe'sspecifications.Somearefreeand
some are commercial software. Most plugins work with only Photoshop or Photoshop-
compatible hosts, but a few can also be run as standalone applications.

There are various types of plugins, such as filter, export, import, selection, color
correction, and automation. The most popular plugins are the filter plugins (also known
asan8bfplugins),availableundertheFiltermenuinPhotoshop.Filterpluginscaneither
modifythecurrentimageorcreatecontent.Belowaresomepopulartypesofplugins,and some
well-known companies associated with them:

 Colorcorrectionplugins
 Specialeffects plugins
 3Deffectsplugins

AdobeCameraRaw(alsoknownasACRandCameraRaw)isaspecialplug-in,supplied free
by Adobe, used primarily to read and process raw image files so that the resultant
images can be processed by Photoshop. It can also be used from within Adobe Bridge.
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1. Whatis Photoshop?

Adobe Photoshop isaprofessionalimage editingsoftwarepackagethat canbeusedby
experts and novices alike. While this handout offers some very basic tips on using the
toolsavailableinPhotoshop,morecomprehensiveguidancecanbeaccessedontheweb or in
the help menu of your version of Photoshop. The version used for this tutorial is Adobe
Photoshop CS.2. about the Work Area

The work area can be intimidating to work with because of all the complex functionality
but with a quickbreakdown of the available featuresand their uses, you will be readyto
comfortably navigate the work area with ease. The work area in Photoshop has the
following basic functionality.

Features:

• MenuBar–thisiswhereyoucanaccessmostofthecommandsandfeaturesin Photoshop

• DrawingPalette –wheretheimagebeingworkedonwill appear

• Options bar

• Contentsensitivedisplayoftooloptions– changesasdifferenttoolsareselected

• DisplayusingWindow>OptionsorClickatoolinthetoolbox.

Lasso options bar
• Toolbox -forcreatinganeditingimages(displayorhideusingWindows>Tools)



• Palettes-tomonitorandmodifyimages(thereare5palettesbydefault)

• PaletteWell -toorganizepalettesinworkarea

• Dragapalette’stabintothepalettewelltostoreitinthepalettewell

• Onceinthepalettewell clickonthepalettetab touseitWebworks.

3. Resizing ImagesandSizeGuide

Whenworkingwithimagesforawebsite,youwillneedtoresizeyourimagestosuityour
particular purpose. Here is a basic guide that can help you decide on what is suitable.
(Theunits usedhere are pixels, which are standardunits acrossallcomputerplatforms.
The conversion between pixels and inches is roughly 1” = 72 pixels or 1cm = 28 pixels)
to use this particular unit of measure you will need to adjust your preference settings by
selecting Edit > Preferences > Units and Rulers and changing the units and rulers to
measure in pixels.

4. Selection

There are several ways to select images or portions of images in Photoshop. Here are
few basic methods to do so:

Addingtoa Selectionandmakinga square

• UsetherectangularSelectionToolontheToolboxtoselectareatoworkon.

• Toaddtoaselection,holdShiftbeforedragging.

• Tomaketheselectionexactlysquare,startdragging,thenhold Shift.

• YoucanpressCtrl+Dto"deselect"andremovetheselectionatanytime.

EllipticalSelectionsandsubtractingSelections

• HolddownontheSelectionToolontheToolbar,andchoosethe Ellipse.

• Tomovetheselection,justclickinsideitanddrag.

• HoldingAltwhileselectingsubtractsthatareafromtheselection



5. Cropping
Cropping is the process of removing portions of an image to create focus or strengthen
the composition.

YoucancropanimageusingthecroptoolandtheCropcommand. To crop

an image using the Crop command:

• Selectthepartof theimageyouwanttokeepbydoingoneofthefollowing:

• Withtherectangle,roundedrectangle,or ellipticalmarquee, drag overtheareayou want

Toselect.

• HolddownShiftasyoudragtoconstrainthemarqueetoasquareorcircle.

• To drag a marquee from its center, hold down Alt (Windows) or Option (Mac OS) after
you begin dragging.

• ChooseImage>Crop.

Tocropanimageusingthecroptool:

• Selectthecroptool.

• Pressentertoapplytheselectiontothecroppedarea.

6. ModifyColor and effects

Photoshophasmanypowerfultoolstomodifythecolorandeffectsofimages.Youshould
experiment with a few options under the Filters menu to view a few of the available
effects. Some that you may like to try out are:

• To improve the appearance of an image you can simplyselect: Image> Adjustments >
Auto Levels/Contrast/Color

• Filterscanbeusedtoachieveaspecialeffect.Thesearefuntoplaywith!Some examples are:

• Liquefy–toeditoutunwantedareasofyourpictureswithcolorfulswirls

• ArtisticFilters-togiveartisticflaretoasimpleimage



• Textures-tochangethelookandfeelofanimage

7. Layers

• TheLayerswindowshowsthevariouslayersthatyourimageismadeupof.Workshop
Committee of Technology Assist by Students Web works

• Tomake a newlayer, click the NewLayer button (F)orselectingLayer > New> Layer in
the menu bar.

• The backgroundlayercannot be removed,since ithasto serve asthe background”for the
entire image.

• Toworkonadifferentlayer,clickonthatlayer.Theeyeballwillappearnexttothatlayer.

• Youcandraglayersupanddownthelist.

• Remember–createanewlayerforeachpartofyourimage.Thisallowsyoutogoback and edit
the layers individually.

PhotoshopLayers palette:

A. Layerspalettemenu

B. Layer set

C. Layer

D. Layerthumbnail

E. Layereffect

F. newlayericon eyeball

8. Text Editing

Toedittextonthetype layer:

• Alwaysuseanewlayertocreatetext

• Selectthehorizontaltypetoolortheverticaltype tool.

• Select the type layer in the layers palette (which will appear with the icon next to it), or
click the text flow to automatically select a type layer.



• Clicktosetinsertionpointorselectoneormorecharactersyouwanttoedit

• Enter text and format as desired using the character palette (display character palette
using: Window > Character or click Character palette tab if the window is open but not
visible)

• Commitchangestotypelayerbyeither:

• ClicktheCommitbuttonintheoptionsbar

• PresstheEnterkeyonthenumerickeypad.

• PressCtrl+Enteronthemainkeyboard(Windows)orCommand+Return(Mac OS).

• Select anytoolin the toolbox, clickin the Layers,Channels,Paths,Actions, History, or
Styles palette, or select any available menu command.

9. Gradients

Gradientsareagreatwaytointroduceflashy,eye-catchinggraphicsinyourpages.Word
ofcaution–usethemcarefully!Abusinggradientsmayresultinconfusedvisitors.Locate this
button on the toolbar and click on it. Notice that the toolbar underneath the menus
havechangedto:Clickonthesmallbarnexttothemini-gradient(thisisapreviewofthe
actualgradient),andamenuofvariousgradientswillshowup:Youcanalsochangethe
propertiesofthegradientbyclickingonthegradientpreviewbox.Anewdialogboxtitled
“GradientEditor”willopen.Pickinganyboxisfine,butfornow,justpickstheboxwithan orange
background and a yellow stripe. Create a new image, and take your cursor and dragit
across. Dependingonhowyou dragthemouse,you will get agradient.Havefun
experimenting! Workshop Committee of Technology Assist by Students Web works

10. Filetype:GIForJPEG

Whenconsideringwhatformattosaveimagesintherearethreebasicthingstoconsider:
color,sizeandcompressionwhichaffectstheloadingtime.Makingimagefilessmalleris useful
for transmitting files across networks and for archiving libraries of images. This saves
disk space and improves transmission time. It takes longer to decode and view a
JPEGimagethantoviewanimageofasimplerformatsuchasGIF.ThususingJPEGis
essentially a time/space tradeoff: you give up some time in order to store or transmit an
imagemorecheaply.GIFissuperiorinimagequality,filesize,orboth.EditingtoolsCrop.

DodgeandBurntoolsaffectthetone,respectivelylighteninganddarkeninganarea.Blur,
Sharpen, and Smudge affect thefocus in a chosen area. Similareffects can befound in
"Filters." Clone stamp samples from anotherarea. Good for removing specks and other
imperfections.Resampleoftenanduseshortstrokeswhencloningalargearea.Healing



Brush and Patch Tool are similar to Clone Stamp, but preserve lighting/shading and
texture. Avoid crossing into dissimilar (in tone or texture) areas.

Filters

BlurandSharpenfiltersareoftenusedinconjunctionwithselectiontools.Best choices:

Gaussian Blur: Especiallyuseful tode-emphasize backgroundandforegroundobjects.
Motion Blur also works well.

UnsharpMask.Increasescontrastalongperceivededges."Threshold"determineshow high
contrast must be to be affected (Default = 0, sharpens all; higher settings sharpen
onlyhigh-contrastareas).Unlimitedspecialeffects.Posterize,mosaic,emboss,halftone,
chrome, you name it…go nuts!

Optimizingfor the Web

File size is more important forWeb graphics, since download times are a consideration.
Sincecomputermonitorsareunabletodisplayimagesataresolutionhigherthan96ppi, images
for the Web should be smaller files to begin with. Slicing images into pieces further
improves download time. HTML code for the resulting table becomes embedded in the
file. File sizes can be further reduced in a couple of ways: JPG is the format of choice
when subtle gradations of color are involved, as with a photograph. The amount
ofdetaillostincompressionwhensavingasaJPGiscontrolledbychoosingalow(small file size),
medium, or high (larger file size) quality file. Detail loss is cumulative, so
reworkingandresavingJPEGsshouldbeavoided.GIFisthebestformatforsharpedged
graphic images with flat, limited colors. GIFs also preserve transparency; JPGs do not.
Though "lossless" compression is used, GIFs are limited to 256 colors (8- bit). The size
of a GIF file can be reduced by further limiting the number of colors, by applying "lossy"
compression,orbyacombinationofthetwomethods.Filesizesandestimateddownload times
for JPG, GIF, and PNG images can bepreviewed in Image Ready or by choosing "Save
for Web" in Photoshop.

Tools

Upon loading Photoshop, a sidebar with a variety of tools with multiple image-editing
functionsappearstotheleftof thescreen.Thesetoolstypicallyfallunderthecategories of
drawing; painting;measuringandnavigation; selection;typing; and retouching. Some tools
contain a small triangle in the bottom right of the toolbox icon. These can be expanded
to reveal similar tools. While newer versions of Photoshop are updated to include new
tools and features, several recurring tools that exist in most versions are discussed
below.



Pen Tool

Photoshop includes a few versions of the pen tool. The pen tool creates precise paths
that can be manipulated using anchor points. The freeform pen tool allows the user to
drawpathsfreehand,andwiththemagneticpentool,thedrawnpathattachescloselyto outlines
of objects in an image, which is useful for isolating them from a background.



Measuring and navigation

The eyedropper tool selects a color from an area of the image that is clicked, and
samplesitforfutureuse.Thehandtoolnavigatesanimagebymovingitinanydirection, and the
zoom tool enlarges the part of an image that is clicked on, allowing for a closer view.

Selection

Byusingpathselectiontool,wecanselectpath nodes.

Cropping

Thecroptoolcanbeusedtoselectaparticularareaofanimageanddiscardtheportions
outsideofthechosensection.Thistoolassistsincreatingafocuspointonanimageand
excluding unnecessary or excess space. Cropping allows enhancement of a photo’s
compositionwhiledecreasingthefilesize.The"crop"toolisinthetoolspalette,whichis located
on the right side of the document.

Slicing

The"slice"andsliceselecttools,likethecroptool,areusedinisolatingpartsof images.
Theslicetoolcanbeusedtodivideanimageintodifferentsections,andtheseseparate
partscanbeusedaspiecesofawebpagedesignonceHTMLandCSSareapplied.The slice
select tool allows sliced sections of an image to be adjusted and shifted.

Moving

Onceanareaofanimageishighlighted,themovetoolcanbeusedtomanuallyrelocate the
selected piece to anywhere on the canvas.

Marquee

The marquee tool can make selections that are single row, single column, rectangular
and elliptical. An area that has been selected can be edited without affecting the rest of
theimage.Thistoolcanalsocropanimage;itallowsfor bettercontrol.Incontrasttothe crop tool,
the "marquee" tool allows for more adjustments to the selected area before cropping.
The only marquee tool that does not allow cropping is the elliptical.

Lasso

The lasso tool is similar to the "marquee" tool; however, the user can make a custom
selection by drawing it freehand. There are three options for the "lasso" tool – regular,
polygonal, and magnetic. The regular "lasso" tool allows the user to have drawing
capabilities. Photoshop will complete the selection once the mouse button is released.
The user may also complete the selection by connecting the end point to the starting
point. The “marching ants” will indicate if a selection has been made. The "polygonal
lasso" tool will only draw straight lines, which makes it an ideal choice for images with
manystraightlines.Unliketheregular"lasso"tool,theusermustcontinuallyclickaround
theimagetooutlinetheshape.Tocompletetheselection,theusermustconnecttheend



point to the starting point just like the regular lasso tool. "Magnetic lasso" tool is
considered the smart tool.

Quick Selection

The quick selection tool selects areas based on edges, similarly to the magnetic lasso
tool. The difference between this tool and the lasso tool is that there is no starting and
endingpoint.Sincethereisn’tastartingandendingpoint,theselectedareacanbeadded on to
as much as possible without starting over.

Magic Wand

The magic wand tool selects areas based on pixels. The user only needs to click once,
and this tool will detect pixels that are very similar to each other. If the eye dropper tool
is selected in the options bar, then the magic wand can determine the value needed to
evaluatethepixels;thisisbasedonthesamplesizesettingintheeyedroppertool.When the
image requires more than a few clicks, this tool becomes a disadvantage. The user
must decide what settings to use or if the image is right for this tool.

Eraser

The eraser tool does exactly what it’s called. It erases an image based on the layer it is
on. If the user is on the text layer, then any text that the tool is dragged across will be
erased.Theerasedareawillconvertthepixelstotransparent,unlessitisthebackground layer.
The size and style of the eraser can be selected in the options bar. This tool is unique in
that it can take the form of the paintbrush and pencil tools. In addition to the
straighterasertool,therearetwomoreavailableoptions–backgrounderaserandmagic eraser.

Typing

Photoshop also provides toolsfor adding and editing text. The type tools create an area
where text can be entered, and the type mask tools create a selection area that hasthe
shape of text. The type tool creates vector-based text, so symbols, letters and numbers
in various fonts and colors can be re-sized while maintaining the same quality.

Retouching

Thereare several tools that areused for retouching, manipulating and adjusting photos,
such as the clone stamp, eraser, burn, dodge, and smudge and blur tools. The clone
stamp tool samples a selected portion of an image, and duplicates it over another area
using a brush that can be adjusted in size, flow and opacity. The smudge tool, when
dragged acrosspartof animage, stretchesand smudgespixelsasif theyarerealpaint,
andtheblurtoolsoftensportionsofanimagebyloweringtheamountofdetailwithinthe adjusted
area.

Content-aware

Content-awareness is a useful aspect of Photoshop where image editing is done
automaticallyandintelligently.Itcomesintwoforms,content-awarescaling,andcontent-
aware filling, in which elements in a background automatically recompose according to

http://en.wikipedia.org/wiki/Content-aware_scaling
http://en.wikipedia.org/wiki/Content-aware_scaling


the areasa userof the program decides to fill or scale. More specifically, content-aware
scaling works by rescaling an image and causing its content to adapt to the new
dimensions and preserving important areas of it. Content-aware filling functions by
matchingtone,color,andnoiseofanareaoftheimagethatcontainedanobjectordetail in which
the user decides to remove.

Healingtools

With improvement retouching tools like the Clone Stamp tool and Healing Brush tool,
imperfections of an image can easily be removed. These tools essentially function by
locating a source point (or multiple source points) that can be scaled or rotated in order
to cover an imperfection or unwanted detail in a specific area of an image.

Puppet wrap

Similar to the content-aware tool, the puppet warp tool reveals Photoshop’s intelligence
by allowing a user to reposition an object in an image such as a flower or arm. This is
donebyusingpointsthatoutlinethestructureofanobjectandeasilyrepositioninginthe wanted
orientation.

Video Editing

InAdobeCS5Extendededition,videoeditingiscomprehensiveandefficientwithabroad
compatibilityofvideofileformatssuchasMOV,AVI,MPEG-4,andFLVformatsandeasy
workflow. Using simple combination of keys video layers can easily be modified, with
other features such as adding text and the creation of animations using single images.

3D

With the Extended version of Photoshop CS5, 2D elements of an artwork can easily
become three-dimensional with the click of a button. Extrusions of texts, an available
library of materials for three-dimensional and even wrapping two-dimensional images
around3DgeometryareallpossiblewiththisversionofPhotoshop.Realismcanalsobe added
to an image using the 3D features of Photoshop such as animating imagebased lights
and depth of field.

Mobile integration

Third-partypluginshavealsobeenaddedtothemostrecentversionofPhotoshopwhere
technologies such as the iPad have integrated the software with different types of
applications. Applications like the Adobe Eazel painting app allows the user to easily
create paintingswiththeirfingertipsanduseanarrayofdifferentpaintfromdrytowetin order to
create rich color blending.

CameraRaw

WiththeCameraRawplug-in,RAW imagescanbeprocessedwithoutthe useof
AdobePhotoshop Light room, along with other image file formats such as JPEGs, TIFFs,
or PNGs. The plug-in allows users to remove noise without the side-effect of
oversharpening, add grain, and even perform post-crop vignetting.
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WEBSCRIPTLANGUAGEHTML
IntroductiontoHTML

HTML (Hypertext Markup Language) is used to create document on the World Wide

Web. It is simply a collection of certain keywords called ‘Tags’ that are helpful in writing

the document to be displayed using a browser on Internet. It is a platform independent

language that can be used on anyplatform such asWindows, Linux, Macintosh,and so

on. To display a document in web it is essential to mark-up the different elements

(headings,paragraphs,tables,andsoon)ofthedocumentwiththeHTMLtags.Toview a mark-

up document, user has to open the document in a browser. A browser understands and

interpret the HTML tags, identifies the structure of the document (which part are which)

and makes decision about presentation (how the parts look) of the document.HTML

also provides tags to make the document look attractive using graphics, font size and

colors. User can make a link to the other document or the different section of the same

document by creating Hypertext Links also known as Hyperlinks.

WEBDESIGNING
Website: CollectionofWebPagesandWebPagesismadebyHTMLTags.

Internet:24HourspresenceonInternetwithWorldWide Reach.

Webdesigning:StaticSite:WithoutDatabase|Photoshop(WebTemplates/ Homepage)

HTML|DHTML Dreamweaver|FlashAnimation|Css&DivTag.

Webdevelopment:DynamicSite: DatabaseSite|JavaScript|ASP.NET|PHP|Ms- Access |
MySQL | Sql Server

RequirementforWebsite:DomainName|Hosting(ServerSpace)|Website

HTML - Hyper Text Markup Language The language used to develop web pages is
calledHTML.HTMListhelanguageinterpretedbyaBrowser.Webpagearealsocalled html

documents. HTML is a set of special codes. HTML isspecified on TAGS.

Forcreation ofHTML fileswe required twoways:



Editor:ForwritingpurposeormakingHTMLfilesNotePadisbesteditoritis support
coding language.

Browser: For output display there are of two type of browsers Internet Explorer
and Netscape Navigator.

Thecontentsof HTMLpagearewrittenin Tags/Attributes.
HTMLTags:Tagsareinstructionsthatoneembeddeddirectlyintothetextofthe

document. An HTML tag is a signal to a browser that it should do something other than

just throwtext up on the screen. Byconnection all HTML tags begin with an open angle

bracket (<) and end with a Closes angle Bracket (>) HTML tags can be of two types:

Paired Tags: A tag is said to be paired tag if it, along with a companion tag, close the
text.

Singular Tag: The second type of tag is the singular or stand-alone tag. It does
not have a companion tag.

TagAttributes&Value:AdditionalinformationsuppliedtoanHTMLtagis known as
Attributes of a tag. Attributes are written immediately following the tag, separated by a

space. Like:

<HRSize=5Color=”Red”Width=70%Align=”Right”>

HereHR = Tag

Size, Color, Width, Align = Attributes

5, Red, 70%, Right= Values

Basicstructure ofHTMLDocument:

EveryHTMLprogramhasarigid structure.

<HTML> StartTag|OpeningScript

<HEAD> Informationplacedinthissectionisessentialtotheinnerworkingof the

document and has nothing to do with the content of the document.

<TITLE>Explanation of page purpose, Display in Title Bar of I.E.

</TITLE> ClosingTag

</HEAD> ClosingTag

<BODY> InformationandLinks/SecondaryLinks/Footersmeananytypeof Text
or Graphics for Page.



</BODY> ClosingTag
</HTML> ClosingTag|ClosingScript

ParagraphBreaks:Ablanklinealwaysseparateparagraphsintextualmaterial.Thetag that
provides this functionality is <P>.<P>tag is used to create a new paragraph.

Line Breaks:When text needs to start from a new line and not continue on the
sameline, the <BR> tag should be used.

HeadingStyle:HTMLsupportssixdifferentlevelsofheadings.Thehighest-levelheader format
is

<H1>andthelowestlevelis<H6>.

AlignAttribute:Alignmentattributesareoftenusedwiththetext,image.
Align=Left/Center/Right<H1 Align=”Left”>Soft Brain</H1>

DrawingLines:Thetag<HR>drawslinesandhorizontalrules.TheAttributestothe
<HR>tagare:

<HRSize=5Color=”Red”Width=70%Align=”Right”>

TextLevelElements:TextlevelElementschanges theappearancetofunctionof text.
Bold: Boldelement<B>and</B>causestexttoappearinaboldtypeface.

<B>SoftBrain</B>

Italic: Italicelement<I>and</I>causesthetexttoappearinItalictypeface.

<I>SoftBrain</I>

Underline:Underline element <U> and </U> causes text to underline.
<U>

Soft Brain </U>

Strike: Strikeelementindicatesthattextenclosedin<S>and</S>willhave a line
drawn in the middle of text.

<S>SoftBrain</S>
Teletype: Teletypeelementchangesthefontlikeamonospacedtypewriterfont.



<TT>SoftBrain</TT>



Superscript: Raisedonepointtextupperword15thAugustorSoftBrainTM.

15 <SUP> th </SUP>August 15th August

Subscript:TextRaiseddownonepointdownward.

H<sub>2</sub>SO<sub>4 </sub> H2SO4

ControllingFontSizeandColor:Alltextspecifiedwithinthetags<Font>and</Font> will
appear in the font size and color as specified as attributes of the Tag <Font>The
attributes:

Face=Setsthefonttobespecifiedfontname.
Size=Setsthesizeofthetext.Sizecantakevaluesbetween1to7.
Color=Setsthecolorofthetext.

<Fontface=“Arial”size=4color=”green”>SoftBrainInformaticsTechnologyPvt. Ltd.
</Font>

BgcolorAttributes: Specifiesbackgroundcolorusingcolorname.
<BodyBgcolor=”RED”>

TextAttributes: Specifiesforegroundcolororthecolorofthetext.
<Body Text=”Aqua”>

UsingSpecialCharacters:

LIST STYLE
Listsarethebestmethodoforganizinginformationandpresentingitinastructure fashion

basically there are three kinds of lists. They are:

Ordered List (Numbering): An ordered list start with the tag <ol> and ends with </ol>.
EachListItem<Li>startwithtag<Li>.Iftag<Li>isnotpresentatthebeginning;thelisted items

appear on the same line.

Non-breakingspace
Copyright Sign

&nbsp;
&copy; Copyright©

RegisteredTrademark &Reg; Softbrain ®

Trademark &#8482; SoftbrainTM



Using Attributes: Type Attribute type=”1” will give
Counting numbers (1, 2..........) type=”A” will give Uppercase
letters (A, B.........) type=”a” will give Lowercase letters
(alb..........) type=”I”willgiveUppercaseRomannumerals.(I,II,
III......)type=”i”willgive Lowercase Roman numerals.(ixia. )

Start Attribute: Thestartattributeallowsyoutospecifythebeginning ofthelist’s
numbers. (Start=”1”)

UnorderedList(Bullet):Weusethetag<UL>and</UL>forunorderedList.

AttributesofUnorderedList

type=”circle” type=”square” type=”disc”

Definitionlist:Thedefinitionlistusesthe<DL>starttagandthe</DL>endtagtocreate a
definition list. Definition list consists of two parts.

Definition term=Appears after the Tag <DT>

Definitiondescription=AppearaftertheTag<DD>

Result in Internet Explorer: KEYBOARDANINPUTDEVICE

ADDITONOFGRAPHICS/IMAGESINHTMLDOCUMENTS
Otherthantext,HTMLallowsplacingofstaticandanimatedimagesinanHTML

page.

ThecommonlyusedimagefiletypesareGIF(GraphicInterchangeFormat)JPEG(Joint

Photographic Experts Group) also called as JPG. To add an image in HTML document,

you just need to include the <IMG> tag with a reference to the desired image. The

<IMG>(image)tagisanemptyelement(i.e.itdoesn’trequireaclosing tag).

<IMGSRC=”imagename.gif”>

<IMGSRC=”imagename.jpg”>

ImageElement Attributes:

Align AttributeswithText:Align=Top/Middle/ Bottom



E.g.:<Imgalign=”middle”src=”picture.gif”>

AlignAttributeswithFloatingImage:Align=Left/ Right

Border:specifiesthesizeof thebordertoplacearoundtheimage.
Height: specifiestheheightofthe image.

Width: specifiesthewidthofthe image.

Hspace: indicatestheamountofspacetotheleftandrightofthe image.

Vspace: indicatestheamountofspacetothetopandbottomofthe image.

Alt Attribute:ALTattributeforthe<IMG...........>tagallowsforsubstitutionofadescription
stringoftexttoholdtheplaceoftheimage.

<ImgAlt=”SuccessIsAJourney”Src=”Image.jpg”> Alt

working for text

<ahref=”filename.html”title=”SuccessIsAJourney”>linkcontent</a>

CREATINGTABLES
Table present information in the form of rows and columns. To include a table in your
webpagesyoufirstneedtocreatethetablestructureandforthatyouuseHTML’sTable Tags.

<TABLE>Thetable’sbeginningwitha<TABLE>tagandtheendwitha
</TABLE>tag.

<TR>Thetablerowelement<TR>withanoptional</TR>endtagcreatesa horizontal
row of cell.

<TH>Thetableheading<TH>withanoptional</TH>createsleadingcells.
<TD>Thetabledataelement<TD>tagswithanoptional</TD>endtag.

Table Attributes:<Align>Attribute:

<TableAlign=”Left”/”Center”/”Right”>

<Border>Attribute: <Table Border=5>

BgcolorAttribute:<TableBgcolor=”ColorNameorColorValue”>

<TrBgcolor=”ColorName”>



<TdBgcolor=”ColorName”>

<ThBgcolor=”ColorName”>
BackgroundAttribute:ThissetsanimageontheBackgroundof table.

<TableBackground=”Computer.jpg”>

Caption:Thistagisoptionalanditcontainstablesdescription.
<CaptionAlign=Top/Bottom/Left/Right>CaptionText</Caption>

Width & Height Attribute: <Table Width=”300” Height=”400”>

Cell spacing Attribute: You can use cell spacing attribute to control the spacing
between each cell in the table.

<Table Cell spacing=”Number”>

CellpaddingAttribute:(Spaclinebetweencellcontentandcellborder)

<TableCellpadding=”Number”>

RowspanAttribute:Therowspanattributeisusedinacelltomakethecell’s content
merge with another cell in a row.

<TdRowspan=”Number”> <ThRowspan=”Number”>

ColspanAttribute:SimilartoROWSPAN,COLSPANattributeisusedinacellto make
the cells content merge with another cell in a column.

<TdColspan=”Number”><ThColspan=”Number”>

LINKINGDOCUMENTS

LINKS:HTMLallowslinkingtootherHTMLdocumentsaswellasimages.

ClickingonaSectionoftextoranimageinonewebpagewillopenanentirewebpageor an image.

The text or an image that provides such linkages is called Hypertext, a Hyperlink or a

Hotspot. Every Hyperlink.

1. Appearsinbluecolor.

2. Thehyperlinktext/imageis underlined.

3. When the mouse cursor is placed over it, the standard arrow mouse cursor changes
to the shape of a hand.



Thebluecolor,whichappearsbydefault,canbeoverridden.Tochangethese

linkcolorstherearethreeattributesthatcan bespecifiedwiththe<BODY>tag.These are:

Link:Changethedefaultcolorofahyperlinktowhatevercolorisspecifiedwiththistag.
Alink:(ActiveLink)Changesthedefaultcolorofahyperlinkthatisactivatedtowhatever color is
specified with this tag.

Vlink:(VisitLink)Changesthedefaultcolorofahyperlinkthatisalreadyvisitedto whatever
color is specified with this tag.

The Anchor Tag: Anchor elements are used to link between two or multiple HTML
documents.”Anchor” tag starts with <A>and enclose with </A>.The <A>tag requires the

HREFattributeand(hyperlinkreference)attributeacceptstheURLofthelinkedpage.

<AHREF=”filename.html”>content</A>

Everyhyperlinkhastwocomponents:Thesourceandthedestination.

<ahref=”http.//www.yahoo.com/”>OPENYAHOOSITE</A>

Images As Hyperlink: Just as text can act as a Hyperlink, so also images can act
ashyperlinks.

<Ahref=”abc.html”><imgsrc=”image.jpg”></A>

ExternalLink: linkswithotherhtmldocument.
InternalLink:linkinasamedocument.Theanchorelementisusedtocreateboth external and
internal links.

NameAttribute:NamedAnchorisusedtocreatelinkstoaspecifiedsectionwithin document.

Thisisatwostepprocess: AtTopof pageafterBodyTag

<ANAME=”LOCATION”>

AtbottomofpagebeforeBodyTag

<AHREF=”#LOCATION”>Content</A>

MARQUEE

http://www.yahoo.com/


MarqueeTag: Forscrollingtextand image.
<Marquee>-----------------------</Marquee>

MarqueeAttributes

<Marqueebehavior=”slide”> </marquee>Inthistextscrollsforonetime only.
<Marqueebehavior=”alternate”></marquee>Inthistextwillscrollcontinuouslyleft to
right.

<Marqueebehavior=”scroll”></marquee>Inthistextwillscrollcontinuously.

For direction of scrolling

<Marquee behavior=”slide” direction=”right”/”up”/”down”>
Forbackground color/width/height

<Marquee behavior=”slide” bgcolor=”red” direction=”right” width=”500”
height=20>

Forspeedcontrollingin marquee

<Marquee scroll amount=1 maximum slow & 1000 maximum fast>
<Marqueescrolldelay=1000maximumslow&1maximumfast>

MULTIMEDIA
Multimediarefersto“MultipleMedium”thatistheabilitytoaddsoundandmoving

pictures to your WebPages.

AddingVideo:<embedsrc="movies.mpg"height="200"width="200">

Adding Sound:Webpage contain basically two varieties of sounds that play

whenever the visitor accesses the WebPages that is the background sound, and when

the visitor clicks something. The most common sound file formats are MIDI (Musical

InstrumentDigitalInterface),WAV(asinWave),AU(Audio)and(AudioInterchangeFile

Format).

Soundfilescanbeaddedinmanyoftheways.Wecanusethe<A>anchortagso that the
visitor has the option whether to hear the sound or not. For example:

<Ahref=”music.wav”>ClickHereForBackgroundMusic</A>



Astheuserclickson the text, the background sound starts. So thevisitorhasthe
option whether to hear the sound or not.

Secondoptionrequires<Bgsound>tag:<Bgsoundsrc=”Soundurl”>
Here the src attribute specifies how many times the sound should play. If loop is

specify loop = No or infinite to play the sound is an endless loop.

AddingAnimatedGif’s:(GraphicsInterchangeFormat)

<imgsrc=’A.gif”width=100height=100>

FORMCreation in HTML
Creating A Form:WebPages can be interactive if they collect information from

the user. An HTML form is used for creating interactive web pages. The information

entered by the user is passed back to a web server where it might be recorded in a

Databaseforfurtheruse.So;aformissimplyacollectionoffieldsofinformation.These fields of

information can be in the form of text boxes, radio buttons, pull down menus

etc.Common uses of forms are Online order forms, Feedback forms-mail registration

forms, or any web page in which input is required from the user in order to complete a

given task. An HTML form consists of two parts. The first part, the user can see and

which he fallout and next one is the part, the user can’t see the second part specifies

how the server should process the user’s information. Here we commonly used PHP

script.

TheFormTag:Aformmuststartwitha<FORM>tagandendwitha</FORM>tag.Ithas mainly
two attributes:

1. Action

2. Method

Syntax:<Formaction=”URL”method=get/post>Form

Elements............</Form>

Actionisusedtospecifye-mailaddressthatwillreceivetheforminformation.If you

have written aform handler to which thedata in theformwill be sent, thenyou will have

to add an action=”URL” attribute to specify the location of the handler.



TheMethodattributetellsthebrowserhowtosendtheuser’sdatatotheserver. There are
only two possible values for the method attribute: Method=”get” or Method=”post’.

The default value is “post”.

UsingFormControlElements:Theformelementcancontaindifferentelementsto create
form controls.

InputElement:The<input>tagallowsusertoinputinformation.

Text:Usedtocreatethesinglelinetext boxes.
Password:Similartotext,exceptthecharactersyoutypearenotseenonscreen.

Checkbox: Asonoroffswitch.
Radio:Similartoacheckbox,exceptthatinagroupofradiobuttonsonlyoneradio button

can be on at a time.

Submit: Submitsaformtobe processed.
Reset:Clearsalltheinputona form.

Button:createsabuttonsimilarinappearancetoasubmitbutton.
File:Canbeusedtosendafilefromthesurfer’scomputeralongwiththerestoftheform data.

Form Creation:

Fieldsetandlegendtag: <Fieldset>tagisusedtogroupmoreformcontrolstogether. The
<legend> tag, which is optional these tags require closing tag. The Syntax is:

<Fieldset>

<Legend>GroupLabelText</Legend>

Control1 Control2 Control3 Control4

</Fieldset>

<html>

<head><title>FeedbackOnline Form</title></head>

<bodybgcolor=”black”text=”white”>

<form>

<fieldset>

<legendalign=”right”>Forminfo@softbrain.org</legend>

mailto:info@softbrain.org


Input Element: The <input>tag allows user to input information. The <input>element
consistsof<input>tagalongwithtypeattribute(tospecifywhattypeofformcontrolyou

want),theNameattribute(toindicatethefieldname),andotheroptionalattributes.The

typeattributecanaccepttext,checkbox,radiobuttonsetc.asitsvalue.Belowisalistof all

possible values of Type.

<inputtype=”text”name=”text-id”value=”default-text”size=”n”
maxlength=”n” read only>

The name attribute is used as an identifier for the contents of the form

componentwhentheformissubmitted.Thisnameisnotvisibletotheuserandmustbe unique

within theform. The value attribute is optional and isused to supplyinitial text to the text

field.The contentof this attribute will be shown on the textfield, unless theuser changes

it.Wecanspecifythe physical size of the text inputboxbyusing size attribute. The default

value is usually a length of 20 characters. You can, also set the number of characters a

user can input. The maxlength attribute does this. This setting should not be less than

the value of the size attribute. Otherwise your user won’t be able to type to the end of

the box and might get confused. The default value of maxlength is unlimited. The read

only attribute is used to disable the contents of the text. The <label>tag is used for
given bold heading names in form.

Text field: the most common type of form<input>is text. It presents the user with a
promptforasinglelineof text.Thesefieldsarecommonlyusedforaname,address, email

address etc.

<inputtype=”text”name=”text-id”value=”default-text”size=”n”maxlength=”n”>

<label>Full Name</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp

;&nbsp;&nbsp;&nbsp;

<inputtype=”text”name=”t1”size=25maxlength=25value=””><br>

<label>FullAddress</label>



&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;

<inputtype=”text”name=”t2”size=25maxlength=25value=””><br>

Checkbox: A checkbox is simply an empty box and contain a checkmark when

activated. An input tag with attribute type=”checkbox” offers the user an “on” or “off”

switch.Itissimilartoaradiobutton,butanynumberofcheckboxesmaybeswitchonat sametime.

If a checkboxis switched “on” when theform is submitted, its valueattribute is submitted

as the form data for the named form component. Each checkbox has a separate name

specified by the name attribute. The syntax is:

<inputtype=”checkbox”name=”boxid”value=”checkbox”checked>

<label>Internet/E-Shopping</label><br>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="checkbox"name="c1"value="checkbox"checked>

&nbsp;&nbsp;Computer&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<inputtype="checkbox" name="c2">

&nbsp;&nbsp;Laptop&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<inputtype="checkbox" name="c3">

&nbsp;&nbsp;Ipod&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<inputtype="checkbox" name="c4">

&nbsp;&nbsp;UPS&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<inputtype="checkbox" name="c5">

&nbsp;&nbsp;Mobiles&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;<br>

Radio Button: Radio buttons allows the user to choose one of the several options. On
selectingoneoftheoptionstheotheroptionsareautomaticallydeselected.Thebuttons

appearassmallcircles.Withpromptandtheselectedoneappearswitha soliddotinit. You can

indicate the default choice by using a checked attribute. You have to use a unique value

for the name attribute for all radio buttons in a particular set. Syntax:



<inputtype=”radio”name=”radioid”value=”radiobutton”checked>

<label>Gender</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp; <input
name="radiobutton"
type="radio"value="radiobutton">&nbsp;&nbsp;&nbsp;
&nbsp;Male
&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&n bsp;&nbsp;&nbsp;&nbsp;

<input name="radiobutton"
type="radio"value="radiobutton">&nbsp;&nbsp;&nbsp;&nbsp;Female<br>

Pull down Lists: This element creates a menu control. Using this either a drop down
menu or a list box can be displayed in the web page. Also this element must contain

more than one option. Here you use <Select> instead of <Input> and it has a closing

tag</select>. These fields allow user to select single or multiple responses..The name

attribute establishes a name for the select field and is used for form processing. The

sizeoptionissimplythenumberofoptionsyouwanttoshowinthewindow.Bydefault, its value

is one specifying size value greater than one turns the pull down list into a scrollinglist.

You can use the multipleattribute to set the selectfieldto acceptonlyone

option.ToselectmultipleoptionspressCtrlKeyandclickontheoptions.The<Option> tag

includes the list items. For each list item, there must be an <Option> tag. The closing

tag is optional. You can use Value attribute to specify the text to be submitted

whentheparticularitem isselected.Useselectedattributeto indicate thedefaultmenu item.

<label>Year</label>

<selectname=”Textid”size=”n”mulitple>

<optionvalue=”ChoiceId1” selected>2000</option>

<optionValue=”ChoiceId2”>2001</option>

</select>



<label>Dateof Birth</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;MM&nbsp;&nbsp;&nbsp;

<selectname="s1"size=1>

<optionname="01">january</option>

<optionname="02">february</option>
<optionname="03">march</option>

<optionname="04">april</option>

<option

name="05">may</option></select>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

DD&nbsp;&nbsp;&nbsp;

<selectname="s2"size=1>

<optionname="01">01</option>

<optionname="02">02</option>

<optionname="03">03</option>

<optionname="04">29</option>

<optionname="05">30</option></select>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

&nbsp;

YY&nbsp;&nbsp;&nbsp;

<selectname="s3"size=1>

<optionname="01">2001</option>

<optionname="02">2002</option>

<optionname="03">2003</option>

<optionname="04">2004</option>

<optionname="05">2005</option>

</select><br>



TextAreaTag:Itisanextensionoftextelement.Theinputelementtype=”Text”creates a single
line text box and Textarea tag creates a multiple line text box. It sets an area with in a

form in which the user can type a larger section of text. The text area tag presents a

multiple text window with the size specified by the rows and cols attributes.

Rowsgivetheheightandcolsgivethewidthofthetextarea.

<Textareaname=”text-Id”rows=”n”cols=”n”>TypeanyTexthere...</Textarea>

<label>TypeYourMessage Here</label><br>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<textareaname=”ta”rows=15cols=60></textarea><br><br>

File Control: This control lets the user submit a file on their computer along with the
form.Thesizeattributespecifiesthephysicalsizeofthefieldsinputbox.Theaccepts attribute is

used to restrict the file types allowed in a file upload.

<Inputtype=”file”name=”file-id”size=”n”accepts=”file-type”>

<label>attaches your

Resume</label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<inputtype="file"name="file"><br><hr>

Password:Passwordfieldisexactlysimilartotextfield,exceptthatitdisplays****
(asterisks)insteadoftheactualinput.Thesefieldsaremainlyusedforconfidential

contents.

<inputtype=”password”name=”passwordid”value=”defaulttext”>

<label>Login:</label><br>

<label>User



Name<label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp

;&nbsp;&nbsp;&nbsp;

<inputtype="text"name="t1"size=25maxlength=25value=""><br>
<label>Password<label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&

nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="password"name="pass"size=25 maxlength=25><br><hr>

ButtonValue:Createsabuttonsimilarinappearancetoasubmitbutton,exeptthatthis kind of
button doesn’t do anything in particular. Using button value of type attribute you could

have buttons of your choices. You normally require these buttons for executing various

scripts. These buttons have no default functions like submit & Reset. The name attribute

assigns a name to the button and is used for form processing. The value attributes

accepts a text that appears on the button. The button size will be controlled directly by

the text length. The ONCLICK attribute gives the name of the script that is to be activated

when the button is clicked.

<Inputtype=”button”name=”buttonid”value=”clickhere” onclick=”Script”>

Image Button: Exactly the same as a submit button, except that you can specify any
image instead of the normal gray button appearance. An input element with

type=”Image” creates an image button. Instead of text an image of your choice is

displayed.Theattributesforan imagebuttonaresimilartotheattributesfor<IMG>tag. Here

you have to specify SRC or Images for aligning them in left, center or right

<inputtype=”image”name=”img”src=”pic.jpg”height=50width=100>

Submit Button: Every form must have a submit button as after filling up the form, the

visitorneedstosubmittheinformationtoyou.Aninputtagwithtype=”Submit”provides a

button that submits the information in the complete form to the URL, given as the



actionattributeoftheformtag.Bydefault,“Submit”iswrittenoverthebuttonistaken from the

value attribute. The button size will be controlled directly by the text length.

<inputtype=”submit”name=”sub”value=”Submit”>

ResetButton:Theresetvalueofthetypeattributecleansallformentriestothedefault once or
leaves them blank if no defaults are specified. As the reset button can simply wipe off

all the work done, therefore it should be well labeled and should never be placed before

submit button.

<inputtype=”reset”name=”res”value=”Reset”>

</fieldset>

</form></body></html>

FRAMES
Framesareusedtocreateadocumentthatdividesthebrowserwindowintodifferent parts and
display a different web page in each of them. A frame set document is a document that

defines one or more frames by using frameset and frame elements.

Framescancommunicatewitheachothersothatanactionperformedonapageinone

framecanchange thecontentsandbehavior of anotherframe.A commonframe layout uses

an indexframewith links on the left,anda contentframeonthe right. As you click on the

links on the left frame, the corresponding HTML page will appear on the right frame.

One frame can be used to keep some information static while the other frame can

contain the actual content of different sections of website.

The<Frameset>Tag:Thesplittingofabrowserscreenintoframesisaccomplished with the
<frameset>and </frameset>tags embedded into the HTML document. The

<frameset>tagrequiredoneofthefollowingtwodifferentattributesdependingon whether the

screen has to be divided into rows or columns.



Rows & Cols: Row attribute is used to divide the screen into multiple rows. Cols

attribute is used to divide the screen into multiple colums.It can be set equalto a list of

values.DependingontherequiredsizeofeachRowsandColumns.Thevaluecanbe:

1. Anumberofpixels.

2. Expressedasapercentageofthescreenresolution.

3. Thesymbol,’*’whichindicatestheremaining space.

Example :<Frameset

Rows=”50%,50%></Frameset>Result:Itdividesthebrowserscreenintotwo

equalhorizontal sections.

<FramesetCols=”50%,50%></Frameset>

Result:Itdividesthebrowsersceenintotwoequalverticalsections.

The <frame>tag: Once the browser screen is divided into rows (horizontally) and
columns(vertically),eachdifferentHTMLdocument.Thisisachievedbyusingthe

<Frame>tagwhichtakesinthefollowingattributes:

Name=”name”: Gives the frame a unique name so it can be targeted by other
documents.Thenamegivenmustbeginwithanalphanumericcharacter.<Frame
Name=”AA”>

Src“Url”:IndicatestheURLofthedocumenttobeloadedintotheframe.

CreatingFramedDocuments: Creatingframesisactuallyquitesimple. Firstofallyou need
to decide as how you want to divide the browser’s window of the webpage. Then

writethehtmldocumentthatyouwanttoputinthepagesegments.Inadditiontothisa master

document is to be written which is used to specify what goes where. Suppose we want

to divide a page into two rows and four columns.Then the HTML code for the frameset

will be:

<Html>

<Head><title>FRAMEONLINE..... </title></head>

<Frameset>

<frameset cols="30%,*">



<frameset rows="50%,50%">

<frame name="aa">

<frame name="bb">

</frameset>

<frameset rows="50%,50%">

<frame name="cc">

<frame name="dd">

</frameset>

</frameset>

</frameset>

</html>
The<Frameset>and<Frame>tag:Themasterpagedoesn’thavea<body>tag. Instead, it
uses

<Frameset> tags. The <Frameset>tag is included after the <Head>tag and it

established frames within the HTML document. It does all the dividing. It requires a

closing tag and there maybe anynumberof frameset tags within an HTML document.

The cols attribute is used for vertical frames whereas the rows attribute is used for

horizontalframes.Thewidthorheightisspecifiedasacomma-delimitedlistofsizesin pixels,

percentage or as a proportion of the remaining space by using “*”.

Anotherbasictagisthe<FRAME>tag.Itcontainstheframecontentandittellsthe browser
what to put in each frame. Each frameset must include a

<FRAME>definitionforeachdivision.Asinourexampletherewerefourpartitionsandso four
<FRMAE>tags. Notice that frame does not have a closing tag.



Frame Border Attributes: By default, most browser use a frame border. Border
attributesthatcontroltheframeborder.Toturnoffframebordersetborder=0andfor turn on

border set border=8.You can use these attributes both in the <frameset>or

<frame>tags.Toremoveallthebordersfromyourframesaddtheminthe

<frameset>tagandtoremovetheborderfromindividualframesincludetheseattributes in the

corresponding<frame>tag. You can also set the color of the border by Just add

bordercolor=”purple”.

Controlling Scroll Bars:Scrolling controls the appearanceofhorizontal andvertical scroll
bars in a frame. This takes the value Yes / No / Auto.

In simple words, if the frame’s content goes beyond the frames width, most

browsers add scroll bars so that the user cansee the full content. Even through scroll

barsareusefultoseetheentireframe’scontent,sometimestheycanbeunnecessary and

visually disturbing. You can control the use of scroll bars in a frame by including

scrolling attributes.

Yesmeanstheframegetsscrollbars-whethertheyareneededor not.

Nomeanstherewillbeanyscrollbars,evenifyourframecontentismuchlarge. The
browser will simply display as much as it can.

AutoisdefaultIfscrollbarsareneeded,theyappear,ittheyarenotneededthey stay
conveniently out of the way.

TargetingNamedFrames:Wheneverahyperlinkwhichloadsadocumentinaframeis created,

the file referenced in the hyperlink will be opened and will replace the current document

that is in the frame.

Inasituationwherethenewdocumentneedstobeopenedinadifferentframe while

keeping the document from which the new document was browser open in a different

frame, a simple HTML coding technique must be used.

SincethehyperlinkmustopenanHTML fileinanotherframe,theframeinwhich the

HTML file is to be opened need to be named. This is done by using the name attribute

of the <FRAME>tags. The name takes one parameter, which is the frame name. The

hyperlink tag will have to be supplied with the following information:



1. Thefilename.htmlfilethathastobe opened.

2. The name of the frame where the filename.html file has to be opened. The

attribute via which theframename is specified is theTARGET attribute, which is a

part of the <A></A>tag. This information is given as: TARGET=”framename” <a
href=”filename.html” TARGET=”framename”>Link Content</a>

WEBEDITORNOTEPAD
Therewillbetimeswhenyouwillwanttoedittextualfiles.Textualfilesaredifferentfrom
documents created by WordPad, Word, WordPerfect or some other word processing
program in that they contain no imbedded codes. Editing these files with a word
processing program can introduce special characters that make these files unusable.
Instead, use Notepad which allows you to edit the file as pure text.

TextualfileswillnormallyhaveaTXTfileextension,butthereareseveralspecialpurpose
filesinWindowsthatmustbepuretext.Someofthemoreimportantoftheseincludeyour
CONFIG.SYS,AUTOEXEC.BAT,WIN.INIandSYSTEM.INI(Thesefilesexistedinearlier
versionofWindows,buthavebeeneliminatedinWindowsXP).Youmaygettothepoint of
wanting to play with these files. If so, use Notepad to edit these and not WordPad as
your system cannot use the resulting WordPad file. If you decide you want to create a
web page, but don't have an HTML editor, you will want to use Notepad so as not to
introduce those nasty characters associated with WordPad, etc.

In addition to having a tool to use in editing those special files on your system, learning
Notepad can provide a good foundation for learning some of the other tools that come
with Windows 95/98/ME/XP as well as a number of the applications that you may want
toaddtoyoursystemlater.Notepadissimpletolearnbuthassomefeaturesincommon with
other programs.
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The first thing I want to point out in the above is that I have entered some text into
Notepad.Okay,let'slookatsomeof thefeaturesof Notepad.Let'sstartoffbylookingat each of
the menus across the top of Notepad. Before we go to the individual menus,
noticesomethingaboutthemenubaritself.Seetheunderlinedlettersineachofthemenu
items(File,Edit,Format,View,etc.)(UnderWindows XP,theunderlinesareonlyvisible when
you hold down the <Alt> key - previously the underlines were always visible)? These
are meaningful. If you hold down the <Alt> key and press these letters, you will
selectthatmenu.Obviouslyyoucanselecteachmenuwiththemouse,butthisgivesyou an
alternative way of getting into them. So, you can get into the File menu by pressing
<Alt>F.



FileMenu

This is the File menu. Notice a couple of things about this menu. Notice the "..." at the
endofseveralselections.Thisindicatesthatselectingtheseitemswilltakeyoutoadialog
boxthatwillallowyoutocarryoutthatoperation.Noticethecodedowntherightsideof themenu-
Ctrl+N,Ctrl+O,etc.Thesearehotkeysyoucanusefromwithinthedocument without having to
go into the menu.For example, holding the <Ctrl> key down and pressing N is the same
as going into the File menu and selecting New.These hotkeys can save you some time
in getting to these functions.I wouldn't try to memorize these hotkeys right now, but just
make a mental note of them - you'll learn them over time as you find them appropriate
to your situation.

New-Thiswillstartanewdocument.Ifyouarecurrentlyworkingonadocumentthatyou
haven'tsaved,thesystemwillpromptyoutosavetheolddocumentbeforestartinganew one.

Open... -Thisallows you to bring an existing document into Notepad to viewand/oredit it.
You'll see the following dialog box when you make this selection:



This is the standard Open dialog box used by most Windows programs. It consists of a
toolbaracrossthetopthatshowsyouwhichfolderyouarecurrentlyinalongwithacouple of
control buttons for getting to where you want to go. The main part of the Open dialog
box shows you the files/folders that match the criteria for this application. Next is where
thesystemwilltellyou thenameof thefileitthinksyouwant.Right now,itdoesn'tknow
soitassumesyouwanttolookatallTXTfiles.Nextiswhereyoucantellthesystemwhat
typeoffilesyouareinterestedinlookingat.Bydefault,NotepadlooksatTextDocuments (*.TXT),
but you can change this to look at anything else. Finally, you can either Open the
selection or Cancel this operation.

Save-Ifyouaremakingmodificationstoanexistingfile,Savewillputthechangesback into the
file after confirming that you really want to make the changes. If the file you are working
on is a new file, Save works the same as Save As....

SaveAs...-SaveAs...BringsupadialogboxsimilartotheOpendialogboxabove.



InNotepadyougettosavethefilewhereveryouwant,butthebestplacewouldbeinMy
Documents. It's easy enough to change folders and save afile anywhere on the system
you want. See Naming a File for some suggestions on how to organize your data.

PageSetup...-ThePageSetup...dialogboxallowsyoutocustomizesomeofthethings you see
when you print your document. For example, you can change the size of your paper;
customize the header and footer on each page as well as the margin at the top, bottom
and either edge of the paper. The Page Setup... dialog box looks like this:

Print...-Thisisastandardprintoperation.ItbringsupthePrintdialogwindowwhereyou can
modify the printer information.

Exit - This shuts down Notepad. If the file you've been working on has not been saved,
you will be prompted to save the file before Notepad exits.

EditMenu
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TheEditmenucontainsthosefunctionsthatallowyoutomanipulatetheinformationyou have
on the screen. In this case, there are four items that appear dim in the menu. The
reason for this is that these items are not available at the present time. In most cases,
you have to have something selected for these items to work. Windows does a pretty
good job of communicatingwith you to tellyou what you can and cannotdo. Also notice
thatmostoftheitemsintheEditmenuhaveakeycombinationontheright (Ctrl+Z,etc.). These
are hot keys that can be used from within the document without having to go to
theEditmenu.Forexample,youcandoaCopyfromwithinadocumentbyholdingdown the
<Ctrl> key and pressing the "C" key. I don't recommend that you try and memorize
thesehotkeysjustnow.Instead,Iwouldrecommendthatyoujustmakenoteofthemas you use
the menu items and over time pick up on those you use most frequently.

Undo-NotepaddoeshavearatherneatfeaturecalledtheUndo.Inessence,thisisyour Oops

button. If you make a mistake and suddenly say "Oops", you can select the Undo and
reverse whatever it was you just did. Unless I'm mistaken, the Undo item will only work
on the most recent change you've made to your document.

Cut -Again,thisitemisonlyavailableif youhave somethingselected in yourdocument.
Otherwise you have nothing to Cut. You can select some piece of your document by
holdingdowntheleftmousebuttonanddraggingacrosstheletters/words/sentencesthat you
want to select. Your selection will have white letters and a blue background.
Now you will be able to Cut this selection. Cut removes the selected text from your
documentandputsitontheClipboard.Theinformationisnottotallydeleted,butisbeing held in
case you want to put it somewhere else.
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Copy - Copy is very similar to Cut. The only difference is that with Copy, your selected
textisnotremovedfromthedocument.Instead,acopyofyourselectedtextisplacedon the
Clipboard for you to use later.

Paste-OnceyouhavesometextontheClipboard(usingeitherCutorCopyabove),you
canmovetowhereveryouwouldliketoputthistextandPasteitbackintoyourdocument. In other
words, the combination of Cut and Paste allows you to move text around within your
document while the combination of Copy and Paste allows you to duplicate information.

Delete-WhenyouDeletetextfromyourdocument,itisgone.If youdothisbyaccident, you can
use the Undo function to bring itback, but otherwise it is gone. Delete doesnot place the
selected text on the Clipboard.

Find...-Asyou'vealreadyseen,thisfunctionopensadialogboxthatallowsyoutoenter the text
you want to search for along with a couple of pieces of information to help Notepad
perform the search. If the text is found, it will be selected ready for you to Cut, Copy or
overtype.

FindNext- This functionsimply repeatsapreviousFindThisis useful ifyouhavethe
sametextinseveraldifferentplaceswithinyour document.

Replace-Thisfunctionallowsyoutolocatesometextwithinyourdocumentandreplace
itwithsomeothertext.Itevenhastheabilitytoperformitsfunctiongloballythroughthe document,
but be careful of using this as it can get you into trouble.For example, suppose you
wanted to replace "eat" with "ate" globally throughout a document.This function would
do it, but it would also change "eaten" to "ateen", "cheat" to "chate" and "defeat" to
"defate".
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Go To... - In Goto line, type the line number you want the cursor to jump to.You do not
havetohavelinenumbersinyourdocumentforthiscommandtowork.Linesarecounted down
the left margin beginning at the top of the document.

Select All - If there is something you want to do with all the text in your document at the
same time, all you have to do is select the Select All function and your entire document
will be selected. Now you can either Cut or Copy all the text to your Clipboard.

Time/Date - The Time/Date function is a neat feature of Notepad. Some people like to
keep a journal and in a journal, you might want to have the date and time as part of the
document.Obviously,youcantypeinthedateandtime,butwiththeTime/Datefunction,
Notepad will automatically insert the date and time like this: 7:47 AM 2/27/98.

FormatMenu

WordWrap-Insomecases,youmaywantthetextyoutypetoappearonthesameline, but most
of the time, you'd like to be able to see all the text on the screen at the same time.If
youonlyhavealittlebitofinformation,youmightbeabletoenlarge theNotepad
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window to see all the text. Another way of handling this is to select the Word Wrap
function.Thiswilltakewordsthatdon'tfitintheNotepadwindowandwrapthemdownto
thenextline.Acheckmarkappearswhenwordwrapisturnedon.Wrappingtextenables you to
see all the text on the line, but it doesn't affect the way text appears when it is printed.

Font... - This allows you to change the font used to display the file you have open. It
doesn't change the font of the file itself. It simply allows you to view/edit files using
whatever font you wish.

ViewMenu

Thismenuonlycontainsoneitem;StatusBarwhichwillplaceanextralineatthebottom of the
Notepad window to keep you informedof what has or will be done as you work in
Notepad.

Help Menu



MostprogramsinWindowshaveaHelpmenuthatprovidesinformationaboutusingthat
particular program.The Helpmenumaynotanswerallyourquestionsaboutaprogram, but I
would encourage you to explore what is there before you look elsewhere. Most
companies marketing software today are providing more Help and less hardcopy
documentation.

HelpTopics - Notepadis averysimple program touse asitdoesn'tcontainalotof bells
andwhistles.Asaresult,theHelpTopicsisnotverylong.Youshouldbe abletoexplore allof
HelpTopicsinjustafewminutes.Iwouldencourageyoutodosofortworeasons. First, you'll
know nearly everything there is to know about Notepad. Second, you'll becomefamiliar
with theformat of the HelpfacilityMicrosoft uses so you'll knowwhat to expect in other
Microsoft products.



AboutNotepad-Thefunctionoftheaboutforanyprogramissimplytoletyouknowwhat
versionoftheprogramyouarerunning.Fromtimetotime,theprogrammermightinclude some
additional information about your system, but don't expect this. Here's what my version
of About Notepad looks like:

WEBBROWSERINTERNETEXPLORER
BasicTerms

One of the more popular and fastest growing areas in computing is the Internet.
The Internet is a collection of large computer networks, each of which is a collection of
smaller networks.A network is composed of several computers connected together for
the purpose of sharing information and resources.Consider your computer at Floyd
College.Yourcomputerisconnectedtothelocalnetworkatthecollege,whichisinturn
connectedtoPeachnet,whichisconnectedtotheInternet.Thesoftwareusedtoconnect
computers is called Transmission Control Protocol/Internet Protocol, or TCP/IP.

TheWorldWideWeb

Moderncomputershavetheabilitytodeliverinformationinavarietyofformssuch
asgraphics,sound,video,animation,aswellastext.Theabilitytodeliverinformationin these
different forms is called multimedia.On the Internet this multimedia capability is
available in a form called hypermedia.Hypermedia is any variety of computer media
including text, graphics, video and sound.On the Internet, hypermedia is usually
accessedthroughtheuseofahyperlink.Ahyperlink,orlink,isaspecialsoftwarepointer that
points to the computer that contains the information in whatever format the
informationexists.ThecollectionofhyperlinksthroughouttheInternetcreatesanetwork
oflinkscalledtheWorldWideWeb.EachcomputerintheWebthatcontainshypermedia that
can be referenced by hyperlinks and accessed by other computers is called aWeb



Site.HundredsofthousandsofWebsitesaroundtheworldcanbeaccessedthroughthe World
Wide Web.

URL(UniformResourceLocator)

The URL of a Web page is a unique address of each individualWeb page at the
Web sites on the Internet.A typical URL is composed of three parts.We will use the URL
below to explain the function of each part.

The first part of any web address is the protocol.A protocol is a set of rules that
computersfollow.Mostwebpagesusehttp,whichstandsforhypertexttransferprotocol. HTTP
describes the rules for transmitting hypermedia documents electronically.The protocol is
entered in lower case as http and is followed by a colon and two forward slashes.The
colon and the two forward slashes are required punctuation.Other
protocolsusedontheinternetincludeFTPwhichstandsforfiletransferprotocol,gopher which
givesthe rulesformenu drivendocumenttransfer,andtelnetwhich describesthe rules for
remote terminal sessions.

The second part of aURL is the domain name.The domain name is the Internet
address of the computer on which the Web pages are located.In our example above,
the domain name is www.softbrain.org .The last part of the domain name gives an
indication of the type of organization responsible for theWeb site.For example, com at
the end indicates a commercial site, gov indicates a government site, and edu indicates
an educational site.

ThethirdpartoftheWebaddressisthefilespecificationofthewebaddress.This part of
the Web address shows the filename of the web page as well as which folder or folders
contain the Web page.This is called the path name of the page.

HTML(HyperTextMarkupLanguage)

Web pages are created using a special formatting language called hypertext
MarkupLanguage.HTMLformattingcodesareusedtodisplaythepicturesandgraphics used
to createWeb pages.When you are viewing aWeb page, you can see the HTML
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code used to create the page by selecting the “View” pull-down menu and then clicking
on “Source”.

HomePages

A homepage is the introductorypage of aWeb site.Allotherweb pagesforthat site
can usually be reached through the home page.

InternetBrowsers

AbrowserisaprogramthatmakesusingtheWorldWideWebeasierbyremoving the
complexity of having to remember the rules, syntax and commands for accessing
Webpages.InternetExploreristhebrowserthatyouwillbeusinginthiscourse.Another popular
browser is Netscape Navigator.

StartingInternetExplorer

Before you can use Internet Explorer, it must be installed on your computer and
you must be connected to the Internet through either a local area network such as the
oneatFloyd Collegeoramodem.If theprogram isinstalled,you startInternetExplorer either
by double clicking on its icon on the desktop or by clicking on the start button, Programs,
and then Internet Explorer.When the program starts, you should see the Floyd College
home page.The title of the web page will be displayed in the title bar.

TheInternetExplorerWindow

TheInternetExplorerwindowcontainsseveralfeaturestomakeyourworkonthe
Interneteasy.SeveralofthesefeaturesarecommontoallWindows95applicationssuch as the
title bar at the top with the menu bar containing pull-down menus below it.

Below the pull-down menus is the standard toolbar.Each of the main features of the
Internet Explorer screen is discussed below:

MenuBar

The menu bar contains several buttons which are used to group commands into
groups.File containsthe commandswhich relatetofileoperationssuchassavingafile
orprintingafile.TheEditmenucontainscommandsforeditingyourwork.Todisplaya



menuchoicesuchasFile,clickonthewordFileinthemenubar.Alistofchoicesshould
appearbelowthewordfile.Toselectoneofthesemenuchoices,clickontheappropriate choice
from the pull-down menu.

Displayarea

Most web pages are too large for the entire page to be seen on the computer
screen at one time.When viewing a page in Internet Explorer, you will usually see a
scrollbarattherightsideof yourscreen,whichcanbeusedtoscrolldownandviewthe
restofthedocument.Usethearrowsonthetopandbottomofthescrollbartomoveup and down
through the document.

Some of the words on a web page will be displayed in blue letters.This is the
defaultcoloroftextwhichisahyperlink.Ahyperlinkisapointerthatsendsyourcomputer
toanotherplaceontheInternetsimplybyclickingonthelink.Picturesandgraphicscan
alsobehyperlinks.Asyourmousepointerismovedoverahyperlink,thepointerchanges
toapointinghandtoshowyouthatwhateverisdisplayedonthatportionofthescreenis a link
(pointer) to another place on the Internet.

StandardToolbar

The buttons on the standard toolbar allow you to perform common tasks quickly
andmoreeasilythandoingthosesametasksusingthechoicesonthepull-downmenus. Two
very important buttons are back and forward.These buttons allow you to move
throughthewebpagesthatyouhaveviewedinInternetExplorer.Thebackbuttontakes
youbackonescreenatatimewhiletheforwardbuttonmovesyouforwardonescreenat a
time.Each button on the toolbar is normally gray.Color is added when the mouse pointer
is placed over a button.

Anotherimportantbuttononthe standardtoolbaristheSTOPbutton.Someweb
pagesareverylarge andtakeconsiderabletimetoloadanddisplay.Youmight seethe first part
of a page and decide that you do not need this page or you might decide that you do
not want to wait forthe entire page toload.Clicking the STOP button will stop a web page
from being downloaded.

AddressBar



The Address Bar contains a white text box which displays the URL for the web
page currentlydisplayed.The URL of a web page is its Internet address.These will be
discussedinmoredetailbelow.Youcanalsotypeawebaddressintothisboxandpress ENTER
to load the web page in Internet Explorer.

InternetExplorerIcon

TheInternetExplorerIconrotateswhileaconnectiontoawebsiteisbeingmade, a web
page is being loaded into memory, and a web page is being displayed on your screen.

StatusBar

TheStatusBardisplaystheURLofalinkwhenthemousepointerpassesoverthe link.It
also provides information about the progress of your request to load a new web page.

Toolbars

SeveraltoolbarsareavailableinInternetExplorer.Eachonecontainsbuttonsthat
enable you to easily move between web sites and stop a page from being
downloaded.

InternetAddresses

Allinternetaddresseshavethesamegeneralformatasshownbelow:

http:// www.softbrain.org

The first part, http://, lets the computer know that you are looking for a web server, not
news or mail server.The middle section, www.mcp.com, is the name of the computer
whichcontainsthefilesyouarelookingfor.Thepartthatappearsaftertheslashnames
thefoldersandfilenames of thedocuments youare lookingfor.The .htmlindicatesthe type
of documentyouarelookingfor,in thiscase HyperText Markup Language which is the
standard language in which all web documents are written.

http://www.mcp.com/que/que.html
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You can leave off the “http://” when typing an internet address in Internet Explorer.
InternetExploreralsoassumesthattheaddresswillbe in theform www.mcp.com and it
isnotnecessarytotypethewwwandthecom.Thesewillbefilledinbyinternetexplorer if you
leave them out while typing an internet address.

Note:Manycomputersontheinternetarecasesensitivesoyouneedtomakesurethat every
letter that should be capitalized is capitalized.Also make sure that you are using a
forward slash “/” when necessary instead of the backslash “\”.

TheLinksToolbar

The links toolbar provides a set of links to get the new user oriented to the internet.It
comes with connections to a variety of places including Best of the Web, Microsoft’s

HomePage,theWebGallery,ProductNews,andToday’sLinks.Ifyouselectoneofthe links
shown on this bar, Explorer opens that Web Page.From there you can access
informationindiverseareasbyfollowingthelinksshownonthescreen.Asanexample, if you
choose Best of the Web, you can access information on travel, entertainment, sports,
and much more just by following the links.Travel through the layers and eventually you
will reach an article discussing the subject in which you are interested.

ForwardandBackButtons

Twoofthemostusefulbuttonsonyourscreenareshownintheupperleftcornerofyour
screenonthestandardtoolbar.Thesearetheforwardandbackbuttons.Manytimesas you
explore on the internet, you willneed tomove backto apage that you have already
visited.By clicking the back button you can move back through the pages you have
visitedoneatatime.ThenyoucanclicktheForwardbuttontomoveforwardthroughthe pages
as you browse for information.

Note:Once you move back to your first page, the Back button will be gray
indication that you have traveled as far as possible in this direction.

Note:You can only use the forward button after you have first gone back.Until you
go back, the forward button will be gray indicating that this option is
unavailable.
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HomeButton

Ifyoubecomehopelesslylostinyourinternetexplorations,youcanalwaysclickthehome button
to return to your Starting Page.This page could be out of date especially if it is
onethatisupdatedfrequently,soyoumightneedtoclickontherefreshbuttontodisplay the
latest version of the page.

Links

The World Wide Web is made of millions of web pages that are joined together by
hypertextlinksthatprovideatruly“pointandclick”environmentforaccessinginformation on
your computer.These links are really pointers that instruct your computer where to
goontheInternettoaccesstheinformationyourequested.Bydefault,linksaredisplayed
inbluetext,butawebpagecandisplayitslinksinanycolor.Thereisoneadditionalway that you
can identifya link.When the mousepointeris moved overa hypertext link, the pointer
changes to a hand.When the mouse pointer changes to the pointing hand, you will see
the URL of the link displayed in the status bar located at the bottom of your screen.

Using Links

Links are activated by placing the mouse pointer on the link and clicking once with the
left mouse button.When you click on the link, Internet Explorer loads whatever
document, file, or web page that is attached to that link.While a document is being
loaded,thesmallglobeintheupperleft-handportionofthescreenwillspin.Explorerwill
loadthetextofawebpagebeforeitloadsthegraphicstoallowyoutobeginreadingthe contents
of the page while the graphics, which load much slower, are being displayed.
Whiteboxeswillbedisplayedtomarkthelocationofthegraphicsthatwillbeshownlater. When
the globe stops spinning, the page is completely loaded.

Note:If the globe stops spinninghalf-waythrough aturnorthemessage “connectingto host”
is displayed at the bottom of the screen for an extended period of time, then you
haveaproblemwiththewebpageyouaretryingtoload.Eitherthesitewasbusyorjust not
working for some reason.If this happens, click the “STOP” button located on your
toolbar at the top of the screen.



TheRightMouse Button

Once a web page is displayed, you might want to save the page for later use, or you
mightwanttouseagraphiconthepageaswallpaper.Toperformeitherof thesetasks, use the
right mouse button.Let’s suppose that youfind an image that you want to save on your
hard disk for later use.Point to the image with your mouse and click the “right”
mousebutton.Ashortcutmenuwillpopupgivingyouchoicessuchassavingthe image or
usingthe image as wallpaper.In ourexample we have found an image that we want
tosaveonourharddisk,sowewillselect“SavePictureAs”fromtheshortcutmenuthat
appears.You will be asked to name the image you are saving and select a location for
savingthefile.ClickOKwhenyouarefinished.Youcouldalsoselect“SetasWallpaper” to make
the picture the wallpaper that will be displayed on your desktop.

Using History

InternetExplorerprovidedotherwaystomovearoundinthepagesyouhavevisitedthan just
using the Back and Forward buttons.The History List allows you to instantly move to
any site that you have recently visited.History keeps track of not only the sites you have
visited today, but also keeps track of the sites you have visited in the past few
weeks.Theexactlengthoftimeasitestaysinhistoryisdeterminedbytheuser,butthe default
time is two weeks.To use this feature, click on the History button at the top of your
screen and select the site you wish to revisit from the list.

Savinga WebPage

If you aredoingresearch, you aregoingto need to save the information that you locate
so that you can use it at a later time.Web sites change so often that you cannot be
assured that the files you find on Wednesday will still be there on Thursday.For this
reason,savingfilesisanextremelyimportantfunctionofcomputerapplications.Tosave a web
page, follow these steps:

1. Withthewebpageopen,clickonthefilepull-downmenu.

2. Selectthelocationwhereyouwanttostorethefile.

3. Givethefileanappropriatename.

4. Clickthesavebuttoninthedialogbox.



Note:Whenyousaveawebpage,allyouaresavingisthehtmlcode.Thegraphic that were
on the original site will be missing.

AddingLinkstotheFavoritesMenu

When you are searching on the Internet, you will undoubtedly find certain sites that you
will wish to visit often.You can add these sites to a list of "favorite" sites.This is also
called a bookmark.Bookmarks on the internet are just like bookmarks in a book.The
mark your place.

Toadda webpagetoyourlistoffavorites,followthesesteps:

1. Whileviewingthepageyouwishtobookmark,clickonthe"favorites" pulldown
menu.

2. Select"AddtoFavorites".
3. In the name box, type the name that you wish Internet Explorer to use in

your list of favorites.

4. ClickOK andthissitewillbeaddedto yourlistoffavorites.

AccessingtheFavoritesMenu

To view a page that you have listed as a favorite, simply click on the "Favorites" button
on the standard toolbar and select the web page that you wish to go to.



WEBFRAMEWORKDREAMWEAVER
DreamweaverisawebauthoringprogramthatusesaWYSIWYG“whatyouseeiswhat

youget”interface.TheHTMLcodeisbeingcreatedandisaccessibletoyouifyouwant to play

with it.

Finally,let’sgetstartedwithDreamweaver. Launch

Dreamweaver

1. StartDreamweaver.Youshouldseeastartupscreen.3

Dreamweaver lets you publish your Web site by easily uploading your Web site to a

Web server. Right now we won’t be worrying about that. For now, you will be

creatingand viewing your site locally (which means the site will be located on your

computer).

Weneedtodefine yoursite:

CreateaNewSite

2. FromtheSitemenu,chooseManageSites…TheManageSitesBoxshouldappear.

3. ClickNewandthenchooseSitefromthepop-up menu.

4. ClickontheAdvancedTabunderSiteDefinitionforUnnamedSite1.

LocalInfo

LocalInfoiswhereweputintheinformationaboutthefilesthatareonyourlocalcomputer (which
is where all your files are or will be for now).



5. IntheAdvancedTab,underCategory,chooseLocalInfo.4



6. Next to Site Name, type: My First Dreamweaver Web site. You will use this name
when you go into Dreamweaver to retrieve the files associated with this site. This
name has to be unique within Dreamweaver.

7. NexttoLocalrootfolder,clickontheyellowfoldericontobrowseforwhereyouwant to store
your web site on your local computer. You may wish to create a new folder
tosoreyourfilesin.IstoredmyWebsiteonF:(myflashdrive)inafolderIcalledMy Website.
This is now your Root Folder

8. ClickDONE.YoushouldseeaFilespanelontherightsideofyourscreen.TheLocal View in
the Files Panel will display all the filesfor yourWeb site thatare in the Root Folder on
your computer. Later we will add information about connecting to the server.

TheRemoteViewshowswhichfileshavebeenuploadedtotheserver.

9. Oncewe’veenteredallthisinformationaboutlocalandremoteservers,itwillbeset
upforusnext time weuse Dreamweaveron thiscomputer.Unfortunately, itdoesn’t
work that way on lab computers. If you move to another computer, you will have to
set up your Web site on the new computer as well. 5

WHAT’SAROOTFOLDER?

ThelocalrootfolderiswhereyouwillkeepALLthefilesforyourwebsite.Youcancreate
subfoldersunderit,butconsiderittobetheparentofallparentfolders.You’llkeep allof
thefilesandsubfoldersforyourWebsite(includinghtmlpages,images,multimediafiles, etc.)
either in the root folder or a subfolder under the root folder.

MakingyourfirstWebPage:

10. UndertheFilemenuatthetop,chooseNew.

11. IntheNewDocumentdialogbox,makesureyouhaveBlankPageselected,thePage Type
is HTML, and the Layout is <none>.



12. ClickCreate.YoushouldnowseeablankWebpageintheDocumentWindow.

13. UndertheFileMenu,chooseSave.

14. IntheSaveAsbox,findyourWebsitefolderandsaveyourfileasindex.html

15. Click Save. In the Files panel, you should now see index.html. Congratulations!

You’vecreatedyourfirstWebpageusingDreamweaver.Unfortunately,it’sprettyboring at the

moment.
SavethePage

RULESOFTHUMBfornamingwebfiles:

• Do not use spaces or special characters, such as those found about the number keys
on the keyboard, in your file names. You can use dashes and underscores. (e.g.,
my_page.html)

• Always use a 3- or 4-character file extension for every file you use on the Web. In the
case of a regular Web page, always use .html or .html.

• BeveryspecificaboutcapitalizingbecausemostWebserversarecase-sensitive.

GiveyourWebPageaTitleInthedocumenttoolbar,findtheTitle box.

16. Onthedocumenttoolbar,locatetheTitlefield.6

17. Typeinatitleforyourpage.Feelfreetobecreative(butnotindecent).Hit Enter.

18. The title doesn’t show up on the page, but will appear in tabs and across the top of
browsers. Adding Some Content Add Content to the Page

19. In the Document window, type in a good title. This one will be the head of yourWeb
page. If you can’tthinkof anything, you canalwaysuse, “AardvarkAdoptionSociety of
Delaware”.



20. Add a subtitle. Again, it can be anything you want. If you’d prefer, it could be, “We
speak for

Aardvarkswhocan’tspeakforthemselves.”

21. Now that you’ve got a good title, add some content. Logically, it should go with the
title. Type one or two lines now for now. We’ll add more later. (If you can’t think of
anything, feel free to throw in some of the Aardvark content).

Nowlet’sformatthe content:

22. On theWebpage,highlightthe title.

23. InthePropertyInspector,clickontheFormatdropdownarrow,andchooseHeading 1.
Note:IfyoudonotseethePropertyInspector,chooseWindow>>Properties.

24. Onthewebpage,highlightthesecondlineof text.

25. FromtheFormatmenuonthePropertyInspector,chooseHeading 2.

Note:Whenformattingyourtext, keepinmind thattext sizes inHTML arerelative sizes.
Thismeansthat,whenyourpageisviewedinabrowser,thetextsizewilldependonthe
defaulttextsizesettingsoneachuser’scomputer.Relativesizesgiveusers theabilityto adjust
the text size to suit their individual needs.

This option is especially important for people with visual impairments, but it means that
the appearance of your pages may vary from computer to computer. Playing with Font
Properties

26. HighlighttheSubtitle.Changethefontsizeto24.7

27. Highlight anyword on the page and click the Bold icon ( )on the PropertyInspector.
The selected word appears bold.



28. Highlight the title click the gray square to the right of the Size popup menu in the
PropertyInspector.Agridofcoloredsquaresappears,andthecursorchangestoan eye
dropper.

29. Click the eyedropper on the desired color. The field to the right of the color swatch
reflects the code Web browsers need to correctly display the color you’ve chosen.

30. Clickanywhereonthepagetodeselectthetext.Thepreviouslyselectedtextappears in the
new color.

Alignment

31. 1.Highlightthetitleandsubtitleonthepage.

32. Click the Align Center button ( ) on the Property Inspector. The titles should now be
centered on your page.

CreatingLists

33. Firstweneedtoaddalist.8
34. Typeinatitleforyourlistandthentypeinalistofitems.Makesurethereareatleast 3 items in

your list. Make sure you hit return after each item. (Feel free to use a list from the
aardvark homework if you can’t think of your own.)

35. Highlight the list title and choose Heading 3 from the Format menu on the Property
Inspector.

36. HighlightthelistitemsandclicktheUnorderedListbuttononthePropertyInspector.

37. Theitemsappearasabulletedlist.

38. NowtypeinanotherListtitleandanotherlistof items.

39. HighlightthetitleandselectHeading 3.



40. Highlight the rest of the items and click the Ordered List button on the Property
inspector (next to the ordered list button). The items should now appear in a
numbered list.

41. Saveyourwork.Getintothehabitof savingyourwork regularly.

Page Properties

Inthissectionyouwilllearnhowtosetyourpage’sbackgroundcolor,aswellasthe default text
and link colors. These settings differ from what you’ve done so far on the

Property Inspector because they’ll apply to all the text and links on the page—not just a
selected piece of text.

42. FromtheModifymenuatthetopof theworkspace,choosePage Properties.

43. Tochangethetextcolor,clickthebottomrightcornerofthetextcolorbox.

44. Usingtheeyedropper,chooseacolorbyclickingonanyofthecolorswatches.

45. Similarly, you can change the background color for the page using the Background
color setting. 9

46. Youcanalsochangethecoloroflinks,activelinks,andvisitedlinks.Anactivelinkis
alinkjustwhentheuserclicksit.Acolorchangeletstheuserknowthats/heclicked
onalink.Avisitedlinkisonethattheuserhasalreadyclickedonandvisited.Acolor change
lets the user knows /he’s already visited that link.

47. Select “Links” from the Category menu at left, then make your selections for link,
visited link, and active link colors as you did in Step 3.

48. Click the Apply button to see how your color choices look on the index page. The
Page Properties dialog box will remain on the screen.

49. Whenyou’resatisfiedwiththecolorsyou’vepicked,clickOK.



Note: You can add a background image if you want. Browse to find an image by the
background image.

See what it looks like. Now you know that’s an option. We’ll talk about this option more
later. For now, go back to a solid color background.

Note: If you changed the color for any text using the Property Inspector, those changes
will override general page color choices.

WebPage Preview

As you create a page in Dreamweaver, the page may not look exactly like it would in a
browser. To preview the page in a browser:

50. ChooseFile>>PreviewinBrowser>>i.e.explorerorNetscapeorpresstheF12key. A web
browser, such as Netscape or Internet Explorer, opens and loads the web page.

51. TakealookatyourpagetoseehowitwillappearontheWeb.

52. Whenfinished,closethebrowserandswitchbackto Dreamweaver.

NOTE: Colored or underlined text can be mistaken for links. Choose your color scheme
so that the links stand out from rest of the text. The text and links also should stand out
from the background for readability. When selecting colors, keep it simple. Too many
colors can be distracting or confusing.
AddingImages

Note:Anyeditingorresizingofanimageshouldbecompletedbeforeitisaddedtoaweb page.

53. First you need an image. Feel free to find one on your own that suits the theme of
your web page. If you don’t feel like it, I’ve included an image on my Web site that
you can download.



54. Next,add itto yourWeb page.

55. Placeyourcursorbelowthesub-headerinyourdocumentandpressEntertwice.

56. 2.ChooseInsert>>Image.TheSelectImageSourcedialogboxwill appear.

57. 3.Usingthedialogbox,locateandselectanimage,thenclickOK.10

58. 4.Youwillfirstencounteraprompttoaddaccessibilityattributes:

59. TypeabriefdescriptionoftheimageintheAlternatetextbox,andthenclickOK.

60. Becauseyou’retryingtouseafilethatliesoutsideyourrootfolder(mywebsite),you’ll
receive the following message:

61. ClickYes.TheCopyFileAsdialogboxwillappear.

62. ClicktheSavebuttontoplaceacopyof theimagefileinsideyourmywebsite folder.

63. Theimagewillappearonyourwebpage.

64. ClicktheRefreshbuttonontheFilespanel()andtheimagefilewillappearinthelist of local
files.

Delete an Image

65. IntheDocumentwindow,clickontheimagetoselecttheimage.

66. PresstheDeletekey.Theimagedisappears.

67. Toreversethedeletion,usetheUndocommand.FromtheEditmenu,chooseUndo. The
image should re-appear on the page.

CreateaSecond Page

Next,youwillcreateasecondpageforyourWebsite.

68. Fromthe Filemenu,chooseNew…TheNewpagedialogboxappears.



69. ClicktheCreatebutton.Thenewfilewillappearinthedocumentwindow.

70. SaveyournewpageinthemywebsitefolderasPage2.html

71. IntheTitlefield,typeanappropriatetitleforthispage.We’lleventuallymakeitintoa Calendar
of Events Page, if that helps you decide on a title.

72. Saveyourwork.

Page Planning: When planning your Web site, you will need to decide how to organize
eachWebpage.Whatwillbeplacedoneachpage?Divideyoursiteintopagesforsimple access.
If your readers want to read or print only a calendar of

events, you don’t want them to have to print the entire site to see it. Your site planning
will also include how the pages will be linked together.

Page Navigation

Now that we have two pages, you can link them together.We’ll link the index.html page
to the Page2.html and vice versa. It’s easy in Dreamweaver!

73. UsethetabsontheDocumenttoolbartotogglebacktotheindexpage.

74. Ontheindexpage,typesomedescriptivetextthatdescribesyour Page2.html.

75. Highlightthetextyouwanttomakealink.

76. InthePropertyInspector,clickontheBrowseforFileicontotherightofthelinkbox. A Select

File dialog box appears. 12

77. UsingthedialogboxlocateandselectthefilePage2.html.

78. ClicktheOKbutton.Cool!Youjustmadealink!
79. Theselectedlinkedtextisunderlinedandappearsinthelinkcoloryouchose.Inthe

Property Inspector, the Link field reads: “Page2.html



80. Saveyourwork andpreviewthepageina browser.

81. Testthelink.Whenfinished,returnto Dreamweaver.

82. Now,trylinkingPage2.htmlbacktotheindexpage.

83. Saveyourworkandtestthenewlinkinabrowser.

Note:Thetextyouuseforyourlinkshouldbebriefbutdescriptive,givingyourvisitorsan idea of
where the link will take them even before they click it.

Let’scompare:clickhereformoreinformationlacks detail.

ComparedtoCalendarofUpcomingEvents,whichisclearandconcise?

84. Link to aWebPage

85. Nextlet’saddanexternallink.BythatImeanlet’slinktoaWebpagethatislocated

somewhere on the World Wide Web. We’ll need to use the full (absolute) URL to

link to this page.

86. Gotothebottomof yourindex.htmlpageandtype“MoreinfoonAardvarks”.

87. Highlightthetextyoujusttyped.

88. IntheLinkboxinthePropertyInspector,typehttp://en.wikipedia.org/wiki/Aardvark/ and
press Enter.

89. The text you selected should now link to Wikipedia’s web page on Aardvarks. To
make sure the link works properly, preview the page in a browser.

90. SwitchbacktoDreamweavertocontinueeditingyourpage.

AddanE-mailLink

http://en.wikipedia.org/wiki/Aardvark/


Now you’ll make your e-mail address a link so that visitors can send you questions and
comments via email.
91. Atthebottomof yourpage,type“Sendmeanemail”andhighlighttheword email.

92. From the Inserttoolbar(across the top, belowFile Edit, etc.), click on the envelope
icon to insert an email link.

93. PlaceyourcursorintheE-mailboxandtypeyouremail address:

94. HitOK.Youre-mailaddressappearsasalink.

95. Save your work. Please note that the email link will try to open a desktop email
programifyouhaveoneonyourcomputer.However,ifthecomputeryou’reworking on
doesn’t have an email program set up, testing this link won’t work.

Note:OneoftheadvantagesincreatingacourseWebsiteisaddingappropriatelinksto other
sites on the Web. You may want to compile a list of links that support your instructional
goals. This allows you to supplement your page with appropriate Web
resources.Plusit’salwaysfuntolookaroundatotherrelevantpagestolearnnewthings about
your topic and create your own relevant Webliography.

Creatinga Linkwithin aPage

CreatetheTargetofthe link

96. Placeyourcursoratthetopofyourpage

97. ChooseInsert>>NamedAnchor.TheNamedAnchordialogboxwillappear.

98. In the Anchor Name box, type a name for the anchor. This should describe the
content in that section of the page.



99. ClickOK.Ayellowanchorwillappearjustbeforethetext.Iftheyellowanchorsymbol does
not appear, then choose View >> Visual Aids >> Invisible Elements.

Create alinkto the anchor
100. Atthebottomofthepage,type“BacktoTop”.Highlightthistext.

101. On the Property Inspector, click on the point-to-file icon to the right of the Link field
and drag it to the schedule anchor symbol. (You literally click on it and, without
releasing the mouse, drag it over the anchor symbol in your Web page).

Asthearrowheadmovesovertheanchor,theanchornameprecededbythepoundsign (#) will
appear in the link field. The selected text is now a link, and is underlined with a different
text color.

The form that this type of link uses is different from a standard link. In the link field, a
pound sign appears followed by the name of the anchor. The # (pound sign) indicates
that the link is to an anchoron the Web page.

Note: When planning your Web site, you will need to decide how to organize links
between all the pages.

Agoodpracticeistoplacelinkstootherpagesatthetopandthebottomofeachpage. Also, each

page should be linked to your home page (index.html).

PageLayoutwith Tables

WecanuseTablestolayouttheformatoftextandimages.Atablehasrowsandcolumns
andmaybeusedforlayoutinanumberofways,includingplacingtextorimagessideby side on a
page. In this section, you’ll make a table that shows the Calendar dates and events for
an Aardvark Sanctuary.

Create a Table

102. Place your cursor at the top of Page2.html after the text. Now, you’ll insert a table
with 3 rows and 2 columns.

103. FromtheInsertmenu,chooseTable.TheTabledialogboxappears.



104. UnderTablesize,adjustthesettingsasfollows:

Rows=3

Columns=2
Table width = 75 %

Borderthickness=115

105. ClickOK.Thetablewillappearonyourpage.

106. Placeyourcursorintheupper-leftcellof thetableandtype:“Scheduleof Events”

107. Onthesecondrow,intheleft-handcelltype: Date

108. Pressthe[Tab]keytomovetothenextcellinthetable.

109. Type: Event

110. Pressthe[Tab]keyagaintomovetothenextrow.

111. Type in a date. Move to the next cell, and type in a description of an event. Asyou
type in a long paragraph, the words wrap within a cell.

112. Press the TAB key, and a new row is automatically added to the table. Enter
thedate and event description in the fourth row.

MergeCells

We want the Schedule of Events to be centered across the entire table. To do that, we
first need to merge the two top cells in the table.

113. Click and drag your cursor from left to right across row 1. You’ll now merge those
two cells into one.

114. Choose Modify >> Table >> Merge Cells. Now, in row 1, you should see one large
cell.



Insert anImage

115. Placeyourcursorintheright-handcellof thelastrow.Pressthe[Tab]keytoadda new row.

116. Placeyourcursorintheright-handcellofthatnewrow.ChooseInsert>> Image. The

Select Image Source dialog box appears.
117. Navigate to an image – eitherone you’ve downloaded and ison yourflashdrive or

one from my Web site that you can download.

118. ClickOK.Theimageyouchosewillappearinthetablecell.

Adda newrowto the table.

Afteryouhavecreatedatable,youmayneedtoaddinformationinthemiddleofthe table. You can
add rows or columns to expand the table.

119. Clickinthethirdrowofyour table.

120. ChooseModify>>Table>>InsertRow.

A newrowappears inthe table.

121. Clickinthesecondcolumnofthenewrowandinsertanotherimage(yourchoice). The

image appears in the cell.

122. Click in the cell to the left of the image and type some relevant information in
thecell.

Delete arow

Thetablecanalsobeadjustedbyremovingunnecessaryrowsor columns.

123. Clickinthesecondrowof your table.

124. From the Modify menu, choose Table, and then choose Delete Row. The row and
its contents are deleted. Table

Resizecolumnsandrows

Dependingonthecontentyouaddtoyourtableyoumightfindthatcolumnsaretoowide or narrow.



Youcanadjustthecolumnwidthtobetterfitthecontentinyourtable.

125. Placethecursoroverthelinedividingthecolumns.Thecursorturnsintoa twoheaded
arrow.

126. Clickanddragthetwo-headedarrowtowardtherighttothemiddleofthetable.The
columns are re-sized.

127. Placethecursorovertherightsideofthetable.Clickanddragthetwo-headedarrow to
resize the table again.

128. Saveandpreviewthepage.
Try changing the size of the browser window. Notice that the table size changes as the
browser window size changes – why? The reason the table size is not constant is
because the width of the table is expressed as a percentage of the total width of the
browser window, in this case, 75%. If you wish to lock the table to a specific size, you
have to express the table dimensions differently.

Table dimensionscan also be expressed asfixed using“pixels”. A pixelis a single point in
a graphic image. Screens are divided into thousands (or millions) of pixels, arranged in
rows and columns. On a 17 Web page, a recommended pixel size for a table’s width
would be no higher than 600. (Assuming a screen resolution of 800 x 600).

When your table is selected, you can view and change the table width on the Property
Inspector.

Experimentwith cellcolor andother options

129. Toaddbackgroundshadingtoacellorrow,selectthecell(s)andclickonthebottom corner
of the Bgcolor box on the Property Inspector

130. Clickonaswatchwiththeeyedroppertochooseacolor.

131. Tryvarious formattingoptions forthe rest of the table usingthe PropertyInspector.
Change the size, color or style of the text, and try the alignment options.

132. Saveyourworkand preview.
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